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Produto / Producto / Product: Equipamento de Estereotaxia BMS-125E / Equipo de 

Estereotaxia BMS-125E / BMS-125E Stereotaxic Apparatus 

Modelo / Model:  BMS-125E 

Peso / Weight: 13kg 

Prazo de Validade / 

Período de validez /  

Validity period: 

 

20 anos / 20 años / 20 years 

Reg. MS: 80195520013 

 

 

 

 

 

ATENÇÃO: Utilize o equipamento somente após leitura atenciosa do manual de utilização. 

ATENCIÓN: Utilice el equipo sólo después de leer atentamente el manual de uso. 

WARNING: Please read the instruction manual carefully before using the equipment. 
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1. INTRODUÇÃO  

 

O equipamento de estereotaxia BMS-125E é um sistema que auxilia o neurocirurgião na localização de alvos 

para realização de procedimentos, tais como biópsias, drenagem de abscesso cerebral, cirurgias guiadas, 

drenagem e remoção de hematomas, implantação de isótopos para irradiação de dentro para fora ou 

intracavitária, aplicações em braquiterapia, cirurgia para implantação de eletrodos para estimulação (DBS) 

e lesão de estruturas encefálicas/cervicais. 

 

ATENÇÃO: este equipamento somente deve ser utilizado por profissional médico especializado. 

 

− O equipamento de estereotaxia Bramsys BMS-125E é composto pelos seguintes itens: 

• 1 aro aberto 

• 4 barras de extensão 

• 4 parafusos de fixação das barras de extensão 

• 4 adaptadores redutores de rosca 

• 4 chaves allen (2 de 4mm/2 de 5mm)  

• 2 réguas milimetradas  

• 6 parafusos de fixação da régua milimetrada  

• 1 arco graduado 

• 1 carrinho 

• 2 tubos milimetrados 

• 1 barra vertical “Z” longa 

• 1 guia da barra vertical “Z” longa 

• 1 barra vertical “Z” curta 

• 1 guia da barra vertical “Z” curta 

• 3 referenciais para tomografia (2 laterais e 1 frontal grandes) 

• 3 referenciais para tomografia (2 laterais e 1 frontal pequenos) 

• 6 parafusos de alumínio para fixação dos referenciais 

• 1 segmento reto 

• 1 segmento curvo 

• 2 parafusos de alumínio para fixação do segmento 

 

− Acessórios: 

• 2 a 3 caixas de armazenamento 

• 1 parafuso de aço inox de 30mm 

• 4 parafusos de aço inox de 50mm 

• 4 parafusos de aço inox de 75mm 

• 4 parafusos infantis de aço inox de 75mm 

• 4 parafusos infantis de aço inox de 90mm 

• 1 conjunto retrator isocêntrico (2 retratores isocêntrico e 6 espátulas)  

• 2 adaptadores universal em aço inoxidável  

• 2 braços retratores em titânio 

• 2 braços retratores em aço inoxidável 
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• 1 fixador infantil (2 laterais e 1 frontal) 

• 2 alinhadores de ouvido 

• 1 guia laser 

• 3 adaptadores buchas reutilizáveis para biópsia  

• 3 adaptadores buchas reutilizáveis para cirurgia guiada 

• 3 adaptadores buchas reutilizáveis para drenagem 

• 3 adaptadores buchas reutilizáveis para implantação do eletrodo  

• 3 referenciais para ressonância magnética (1 frontal e 2 laterais)  

• 1 aro aberto em fibra de carbono 

• 1 segmento reto em fibra de carbono 

• 1 segmento curvo em fibra de carbono 

• 2 parafusos de fixação dos segmentos 

• 4 barras de extensão em fibra de carbono 

• 4 adaptadores redutores de rosca em fibra de carbono 

• 1 suporte neuroendoscópio 

• 4 parafusos M8 de alumínio reutilizável 30mm – adulto 

• 4 parafusos M8 de alumínio reutilizável 50mm – adulto  

• 4 parafusos M8 de alumínio reutilizável 75mm – adulto 

• 4 parafusos M8 de alumínio reutilizável 50mm – infantil 

• 4 parafusos M8 de alumínio reutilizável 75mm – infantil 

• 4 parafusos M8 de alumínio reutilizável 90mm – infantil 

• 4 parafusos infantis de aço inox 50mm  

• 4 parafusos M8 de titânio 30mm- adulto 

• 4 parafusos M8 de titânio 50mm - adulto 

• 4 parafusos M8 de titânio 75mm - adulto 

• 4 parafusos M8 de titânio 50mm - infantil 

• 4 parafusos M8 de titânio 75mm - infantil 

• 4 parafusos M8 de titânio 90mm - infantil 

• 4 parafusos M8 plástico com ponta de titânio 30mm - adulto   

• 4 parafusos M8 plástico com ponta de titânio 50mm - adulto   

• 4 parafusos M8 plástico com ponta de titânio 75mm - adulto   

• 4 parafusos M8 plástico com ponta de titânio 50mm - infantil 

• 4 parafusos M8 plástico com ponta de titânio 75mm - infantil 

• 4 parafusos M8 plástico com ponta de titânio 90mm - infantil 

• 4 parafusos M8 plástico com ponta de cerâmica 30mm  

• 4 parafusos M8 plástico com ponta de cerâmica 50mm  

• 4 parafusos M8 plástico com ponta de cerâmica 75mm  

• 4 parafusos M12 plástico com ponta de cerâmica 50mm  

• 4 parafusos M12 plástico com ponta de cerâmica 75mm  

• 4 parafusos M12 plástico com ponta de titânio 50mm 

• 4 parafusos M12 plástico com ponta de titânio 75mm 
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• 1 conjunto arco bilateral (2 semi arco graduado, 1 carrinho, 1 tubo milimetrado, 1 barra         

vertical Z longa, 1 guia da barra Z longa, 1 régua milimetrada) 

• 1 carrinho adaptador para micro registro (de acordo com o modelo do micro registro)  

• 1 apoio dos referenciais 

 

− Opcionais: 

• 1 adaptador para fixador de crânio (de acordo com o modelo do fixador de crânio) 

• 1 suporte de fixação para mesa de tomógrafo (de acordo com o modelo do tomógrafo) 

• Software de planejamento cirúrgico MNPS MEVIS 

• Case de transporte 

 

 

2. INSTRUÇÃO DE UTILIZAÇÃO 

 

2.1 Cuidados iniciais 

• Ao desembalar o equipamento, verifique se não existe dano aparente causado por queda ou manuseio 

inadequado durante o transporte. Caso isto ocorra, entre em contato imediato com o 

fabricante/representante para orientar-se sobre as medidas a serem tomadas. 

• Antes do início do procedimento, lubrifique todas as peças que deslizam entre si, as pontas dos 

parafusos de trava do suporte da régua milimetrada e do suporte da barra vertical “Z”, a parte de baixo 

das arruelas e a superfície de contato do arco no tubo milimetrado utilizando vaselina estéril ou silicone. 

Isto permitirá que o esforço para desapertar ou apertar os parafusos seja menor e, consequentemente, 

a fixação seja beneficiada, além de prolongar a boa performance do equipamento.  

 

2.2 Instalação 

• Examine todos os acessórios antes de iniciar a cirurgia. Certifique-se de que estejam funcionando de 

maneira correta. A montagem incorreta pode produzir mau funcionamento e efeitos cirúrgicos 

indesejáveis. 

ATENÇÃO: a Bramsys se responsabiliza pela segurança, confiabilidade e performance deste 

equipamento desde que o equipamento seja utilizado de acordo com as instruções de uso contidas 

neste manual. 

 

2.3 Fixação do aro no paciente 

• Posição do alvo 

1. Verifique a posição do alvo através de um estudo prévio antes de fixar o aro no paciente; 

2. Posicione o aro acima ou abaixo da região de interesse, nunca na mesma altura, pois impedirá 

sua visualização; 

3. Rosqueie os parafusos diretamente no aro ou nas barras de extensão utilizando os adaptadores 

de rosca. 

ATENÇÃO: escolha o comprimento dos parafusos de acordo com o tamanho da cabeça do paciente, 

certificando-se de que o parafuso não ultrapasse os paralelos do aro. 

 

• Fixação com 3 parafusos 

Para a fixação com 3 parafusos, utilize 1 parafuso pequeno ou médio frontal e 2 traseiros. Caso utilize 

a régua milimetrada na parte frontal do aro estereotáxico, utilize apenas o parafuso pequeno frontal 

para que este não ultrapasse a superfície reta do aro.  
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• Fixação com 4 parafusos 

Para a fixação com 4 parafusos, utilize 2 parafusos frontais e 2 parafusos traseiros. Caso utilize a 

régua milimetrada na parte frontal do aro estereotáxico, certifique-se de que os parafusos frontais não 

ultrapassem a superfície reta do aro. 

 

 

 

 
                                                    

 

 

 

 

             Obs.: os parafusos são registrados e vendidos separadamente. 

 

• Fixação com barras de extensão 

Existem 4 barras de extensão intercambiáveis, as quais devem ser utilizadas quando a fixação do aro 

estereotáxico diretamente no crânio do paciente dificultar a visualização da área alvo. 

Fixe as barras de extensão no aro estereotáxico através dos parafusos correspondentes, utilizando a 

chave allen nº 4. 

 

Parafuso frontal 

Parafuso traseiro 
Parafuso traseiro 

Régua milimetrada 

Parafuso frontal 
Parafuso frontal 

Régua milimetrada 

Parafuso traseiro Parafuso traseiro 
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• Adaptadores redutores de rosca 

Quando a barra de extensão for utilizada, coloque os adaptadores redutores de rosca, rosqueando-os 

pelo lado de dentro das barras. 

 

 

 

               
 

2.4 Montagem dos segmentos: 

 

1.    A necessidade de montar o segmento curvo ou o reto deverá ser avaliada pelo responsável pela 

cirurgia e pela montagem, a fim de aumentar o campo de trabalho. 

 

2.     A substituição do segmento reto pelo curvo é realizada soltando os parafusos de fixação, 

substituindo as peças e reapertando os parafusos, fazendo com que a montagem esteja rígida, para 

esta montagem deve-se utilizar a chave allen n°5. 

 

              

 

 

 

 

 

 

 

 

Parafuso 

Barra de extensão 

  Adaptador redutor de rosca 
 

Barra de extensão 

Parafuso 
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                                 Segmento reto                                Segmento curvo  

 
 

2.5 Preparação para estudo tomográfico 

• Montagem do suporte na mesa do tomógrafo 

1. Fixe o suporte na mesa do tomógrafo; 

2. Com a trava livre, encaixe o aro no suporte movimentando-o até encontrar a posição mais cômoda 

para o paciente; 

3. Trave o suporte do aro com a alavanca plástica e fixe o aro no suporte com os dois parafusos de 

alumínio. 

Os parafusos que travam o aro devem sempre estar em posição contrária aos referenciais, conforme 

exemplificado nas figuras a seguir, evitando que o artefato proveniente da cabeça do parafuso seja 

produzido na imagem. 

Montagem Upward dos referenciais 

 

 

 
 

 

 

 

 

 

 

 

Parafuso em posição contrária ao referencial 

Parafuso 

Referencial 

Parafuso Parafuso 
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Montagem Downward dos referenciais             

 

 
  

 

• Colocação dos referenciais para tomografia no aro 

Coloque os referenciais (2 laterais e 1 frontal) no aro estereotáxico, encaixando-os nos orifícios 

correspondentes, sendo que o referencial frontal se distingue por possuir um orifício no centro e os 

referenciais laterais devem estar sempre com a palavra “Occipital” na parte de trás da cabeça do 

paciente. De acordo com o posicionamento do aro na cabeça do paciente, os referenciais podem ser 

colocados “UPWARD” ou “DOWNWARD”.  

ATENÇÃO: quando utilizar as barras de extensão, a posição dos referenciais é sempre “UPWARD”. 

 

 

UPWARD 

 

DOWNWARD 

 
 

 

        
 

ATENÇÃO: a montagem incorreta dos referenciais acarreta erros de cálculo das coordenadas 

estereotáxicas. 

 

• Cálculo das coordenadas com o software MNPS 

 

Parafuso 

Parafuso em posição contrária ao referencial 

Referencial 

Referenciais para 
Tomografia 
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Conversão de imagens DICOM a IMG 

1. Insira o CD com as imagens estereotáxicas da tomografia no PC; 

2. Copie-as ao diretório MNPS/DICOM; 

3. Abra o diretório da TAC; 

4. Arraste qualquer imagem sobre o ícone CT MevDICOM; 

5. Mostre 12 imagens com o quarto botão; 

6. Ordene as imagens a partir do menu Options → Sort images → z (transversal); 

7. Recorte um quadro onde os referenciais fiquem incluídos (use o quinto botão); 

8. Clique duas vezes no quadro vermelho; 

9. Desative as imagens que são Scout View ou com referenciais unidos utilizando a tecla Space; 

10. Vá ao File → Export to img ou aperte o segundo botão (Guardar); 

11. Responda Yes à pergunta de abrir o MNPS. 

 

Preparação do planejamento do procedimento 

1. Escolha a posição dos referenciais Upward ou Downward a ser utilizada pelo software; 

2. Escolha a posição da marcação (rigth, left, frontal, occipital); 

3. Selecione o tipo de aro a ser utilizado; 

4. Inspecione corte a corte se os referenciais encontrados automaticamente estão corretos, passando 

a imagem com a tecla Enter; 

5. Na janela mosaico (onde aparecem 9 imagens juntas) clique duas vezes em qualquer uma delas 

para ir à janela principal do MNPS; 

6. Já na janela principal, vá a um corte que esteja aproximadamente na altura do tumor (biópsias) ou 

na altura da união do terceiro ventrículo (funcional); 

7. Ajuste a janela usando o botão direito do mouse sobre a imagem principal; 

8. Para um ajuste mais fino do contraste da imagem, clique no botão de brilho e contraste e, com as 

flechas do teclado, mova os níveis observando o histograma da direita da tela. 

 

 Definição das coordenadas estereotáxicas em caso de biópsia 

1. Vá ao nível de um corte aproximadamente no centro do tumor; 

2. Dê zoom sobre a lesão; 

3. Comece a desenhar o perímetro do tumor. Para isso, clique no botão ROI Menu (o que tem um 

lápis e um papel verde), e clique na opção Draw ROI Segment desse menu. Depois de escolher o 

número de ROI e escrever o nome do mesmo, comece a desenhar sobre a imagem. Lembre-se 

que para apagar parte de um ROI, pode-se usar o botão Delete; 

4. Mude de corte e desenhe sobre outros cortes. Termine com o botão de lápis; 

5. Salve o planejamento com o botão que tem o disquete desenhado; 

6. Vá ao ROI Menu novamente (botão de lápis e papel verde) e selecione ROI center to POI para 

definir automaticamente um ponto no centro do tumor; 

7. Através do botão POI Table (ou das teclas Control+End), edite as coordenadas desse ponto. Para 

visualizar a trajetória, escreva no campo FROM do ponto central do tumor a palavra OUT e ajuste 

os ângulos que se deseja para a cânula de biópsia; 
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8. Salve o planejamento e anote as coordenadas que serão utilizadas no equipamento para 

estereotaxia; 

9. Para visualizar a trajetória escolhida, recorra aos cortes axiais, veja em 3D, veja também em 

coronal e sagital. Também se pode fazer um oblíquo; 

10. Para passar de uma vista a outra (coronal ou sagital), deve-se voltar à axial através do botão Goto 

ou com o botão Mosaico. 

 

Definição das coordenadas estereotáxicas em caso de cirurgia funcional 

1. Vá ao nível de AC e com o botão POI marque AC. Faça o mesmo para PC e para IHP; 

2. Reconstrua as imagens paralelas ao plano AC-PC com Alt-F6; 

3. Modifique a posição dos pontos AC e PC à vontade e reconstrua novamente com Alt-F6; 

4. Meça a distância entre os pontos AC e PC com Control+D. Deve estar por volta de 26mm em uma 

anatomia normal; 

5. Verifique a posição lateral do IHP observando a simetria da anatomia na altura do trecho das 

órbitas, em planos paralelos AC-PC; 

6. Reconstrua planos inclinados a 7 graus em relação ao plano de AC-PC através de Shift-F6; 

7. Ative o atlas através do botão atlas; 

8. Verifique se o atlas coincide com a anatomia nas regiões próximas ao terceiro ventrículo e ao 

aqueduto cerebral; 

9. Se não coincidir, volte ao plano AC-PC e modifique o ponto AC ou PC; 

10. Situe a estrutura alvo e coloque um POI dentro da mesma; 

11. Edite a tabela de POIs com o botão POI Table, registrando as coordenadas do ponto alvo (GPI 

etc.) que serão utilizadas no equipamento para estereotaxia; 

12. Para capturar imagens do planejamento, use Alt-C. 

 

 

Para fazer fusão de imagens 

Caso as estruturas a serem trabalhadas não estejam bem definidas na tomografia, pode-se utilizar o 

recurso de fusão de imagem com a ressonância magnética. 

1. Insira as imagens no filtro DICOM para MRI e anote o nome do paciente, indicando a orientação 

das imagens (coronal, sagital ou axial); 

2. Ordene as imagens; 

3. Salve as imagens; 

4. Saia do filtro DICOM; 

5. No MNPSShell, abra Planning → CAT3D for Fusion; 

6. No CAT3DShell abra o CAT3D e carregue as informações/imagens do paciente (MRI) com Load 

Anatomy – Start New Patient; 

7. Clique duas vezes em uma imagem do mosaico; 

8. Marque 4 pontos, por exemplo, OD, OI, Fast e T; 

9. Salve o planejamento; 

10. Com o ESC vá ao menu de início do CAT3D e selecione Export Fusion; 
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11. Volte ao Windows com a tecla do Windows e selecione a janela; 

12. No MNPS, com a TAC, marque os mesmos 4 pontos com os mesmos 4 nomes; 

13. Pressione o botão de Fusão e escolha o paciente (axial, coronal ou sagital); 

14. Com Control+F5 mova a janela da ressonância; 

15. Com Alt+F5 inicie a maximização de informação mútua; 

16. Verifique a posição do ponto alvo e os pontos bases; 

17. Saia da fusão com o mesmo botão de fusão; 

18. Veja o atlas na CT com Shift+F6 e reajuste AC-PC; 

19. Localize o alvo a lesionar e anote as coordenadas que serão utilizadas no Equipamento para 

Estereotaxia; 

20. Salve o planejamento e feche o sistema; 

21. Recomendamos fazer backup das imagens e informações do paciente. 

 

2.6 Montagem e verificação do equipamento de estereotaxia 

 

ATENÇÃO: Todas as peças devem deslizar facilmente umas nas outras. Caso ocorra alguma 

resistência, verifique se a peça está corretamente montada, encaixada ou se algum parafuso de 

fixação está causando interferência. Persistindo o problema, entre em contato com a assistência 

técnica da Bramsys.  

 

• Montagem do carrinho e adaptadores 

Monte os adaptadores no carrinho e no guia regulável da seguinte maneira: coloque os dois 

adaptadores mais longos na parte graduada do carrinho e o menor no lado inferior do guia regulável. 

O adaptador mais longo possui uma marca indicando a posição do furo para fixação da cânula através 

do parafuso de trava do carrinho. 

Obs.: os adaptadores são registrados e vendidos separadamente. 

 

 

                

 

 

Adaptador 

Trava do movimento  z do carrinho 

Marca do ponto zero do carrinho 

Guia 

Adaptadores 
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• Montagem do instrumental 

Introduza a cânula ou o eletrodo no carrinho até o fim do seu curso, onde sua base encoste sobre o 

adaptador. 

Obs.: as cânulas e os eletrodos são registrados e vendidos separadamente. 

 

 

 

• Mira para controle do isocentro 

Verifique a calibração do instrumental, ou seja, se ele está no isocentro, da seguinte maneira: 

1. Monte o conjunto do tubo milimetrado, o arco e o carrinho; 

2. Ajuste no equipamento de estereotaxia as coordenadas obtidas do planejamento cirúrgico; 

3. Introduza a cânula ou o eletrodo, com o carrinho na posição “0” (zero); 

4. Alinhe as duas extremidades da mira olhando através do tubo milimetrado; 

5. Ajuste a área de interesse na cânula ou eletrodo para que fique posicionada no centro da mira do 

tubo milimetrado; 

6. Aperte todos os parafusos de bloqueio de movimento para garantir que as coordenadas ajustadas 

permanecerão corretas; 

7. Complemente a montagem do arco e carrinho no aro estereotáxico e realize o procedimento. 

 

 

 

Instrumental 

Carrinho 

Adaptador 

Tubo 
Milimetrado 



 

 18 

 

 

2.7 Utilização de adaptador para fixadores de crânio 

1. Monte o adaptador no aro estereotáxico e fixe-o adequadamente; 

2. Ajuste o fixador de crânio, escolhendo a posição ideal para o procedimento.                                      

 

2.8 Escalas 

Todas as escalas estão em milímetros (mm) e os ângulos em graus sexagesimais. 

 

2.9 Tolerância 

A precisão das coordenadas do equipamento é de  0,5mm. 

 

2.10 Esterilização 

O equipamento de estereotaxia pode ser esterilizado em óxido de etileno, peróxido de hidrogênio ou 

autoclave a vapor (requer caixa de armazenamento especial), de acordo com as informações do 

quadro abaixo:  

 

Método 
Parâmetros de 

Esterilização 
Observações 

Óxido de etileno (ETO) 2 a 3 horas entre 50 e 60°C. 

Depois de esterilizado, o 

equipamento deve passar por 

aeração mecânica por 240 minutos 

ou aeração ambiental de 24 a 72 

horas. 

Peróxido de hidrogênio 

(STERRAD) 

Aproximadamente 75 

minutos. 
- 

Autoclave a vapor (requer 

caixa de armazenamento 

especial) 

Aproximadamente 1 hora e 

15 minutos a 134°C. 

Não esterilize em ciclos rápidos ou 

acima de 150°C. 

 

 

Não utilizar o método autoclave a vapor nos seguintes acessórios: 

 

- Parafusos de plástico com ponta de titânio, parafusos de plástico com ponta de cerâmica, 

referenciais para ressonância magnética. 

 

 

3. PRECAUÇÕES, RESTRIÇÕES, ADVERTÊNCIAS E CUIDADOS ESPECIAIS 

 

3.1 Precauções 

• Não utilize o equipamento e seus acessórios após sua vida útil. Pode ocorrer mau funcionamento dos 

mesmos, dificultando o trabalho do usuário e/ou causando danos ao paciente. Apesar do equipamento 

não utilizar itens descartáveis nem gerar resíduos após sua utilização, após a vida útil, este deve ser 

segregado para possível revalidação ou descartado de acordo com a legislação local vigente. 

 



 
 

19  

3.2 Restrições 

• Todas as partes e acessórios pertencentes ao equipamento são de uso exclusivo com o mesmo. 

• Os seguintes produtos são recomendados para uso com o BMS-125E: 

Cânulas para estereotaxia Bramsys 

Adaptadores Bramsys 

Parafusos Bramsys 

Eletrodos para cirurgia funcional Bramsys 

 

ATENÇÃO: o uso de qualquer parte, acessório ou material não especificado é de inteira 

responsabilidade do usuário. 

 

3.3 Avisos e advertências 

• Evite queda, torção, esmagamento, impacto, ou ação que venha deformar o equipamento. 

• Deformações na estrutura do equipamento comprometem sua precisão, podendo ocasionar danos ao 

paciente. 

• Fixe adequadamente as partes móveis do equipamento. 

• Movimentações das coordenadas estereotáxicas decorrentes de deslocamento acidental dessas 

partes irão alterar a posição do alvo pré-determinado, podendo ocasionar danos ao paciente. 

• O equipamento deve ser limpo e esterilizado corretamente conforme as instruções contidas no manual 

do usuário, caso contrário, haverá a possibilidade de contaminação bacteriana e/ou viral, podendo 

causar complicações infecciosas ao paciente. 

• Esforço excessivo na fixação do aro estereotáxico no crânio, acima do suportado pela estrutura óssea, 

poderá ocasionar lesões no paciente. 

• A leitura inadequada das escalas do equipamento, por erro de interpretação do usuário ou por 

desgaste da pintura nas escalas, pode provocar erro na execução do procedimento, podendo 

ocasionar danos ao paciente. 

 

 

4. ARMAZENAMENTO, LIMPEZA, CONSERVAÇÃO E TRANSPORTE 

 

4.1 Armazenamento 

• Mantenha o equipamento em sua embalagem original, em local protegido de umidade excessiva, 

chuva e sol direto. 

 

4.2 Limpeza e desinfecção 

• Para limpeza externa do aparelho após cada procedimento, utilize somente sabão neutro e água 

morna. Para secá-lo, utilize preferencialmente ar comprimido ou pano seco limpo. 

• Não empregue solventes orgânicos, como thinner, ou detergentes que contenham solventes tais como 

éter, tira manchas, gasolina etc. para limpar o equipamento. Não utilize aerossóis ou aplicadores a 

base de spray líquido. 

• Não utilize material microabrasivo ou palha de aço na limpeza. 

• Lave também a caixa utilizando uma esponja macia ou pano molhado com água e sabão neutro e 

seque-a após a lavagem. 
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4.3 Lubrificação 

• Lubrifique todas as peças que deslizam entre si, as pontas dos parafusos de trava do suporte da régua 

lateral milimetrada e do suporte da barra vertical “Z”, a parte de baixo das arruelas e a superfície de 

contato do arco no tubo milimetrado utilizando silicone ou vaselina estéril antes do início do 

procedimento. 

 

4.4 Conservação 

• Mantenha o equipamento limpo e seco para a próxima utilização. 

• Mantenha-o em local limpo e longe de poeira. 

 

4.5 Transporte 

• Evite vibrações e impactos e não deixe o equipamento cair no chão. 

• Não permita que o equipamento fique exposto à chuva ou à umidade excessiva. 

• Todas as peças devem ser acondicionadas dentro da caixa de transporte. 

• Verifique se todas as peças estão posicionadas e fixas corretamente em seus lugares. 

 

 

5. DESCRIÇÃO DA EFICÁCIA E SEGURANÇA DO PRODUTO 

 

5.1 Efeitos secundários ou colaterais indesejáveis e contraindicações 

• Este equipamento não produz nenhum efeito secundário ou efeitos colaterais indesejáveis se todas as 

recomendações descritas neste documento forem tomadas. O equipamento não possui 

contraindicação. Somente pode ser usado ou operado por profissional médico especializado ou 

supervisionado por ele. 

 

5.2 Manutenção preventiva 

• Para garantir o bom funcionamento e a segurança do equipamento, envie-o à Bramsys a cada 12 

meses para manutenção preventiva. 

 

5.3 Manutenção corretiva 

• Caso ocorra algum problema no equipamento ou em suas partes, envie-os à Bramsys com a descrição 

do problema. 

 

ATENÇÃO: solicite a assistência técnica através do Serviço de Atendimento ao Consumidor (SAC) 

pelo telefone (11) 5013-0010 ou pelo e-mail sac@bramsys.com.br. 

 

5.4 Descrição da segurança e eficácia 

• A segurança e a eficácia no uso do equipamento são obtidas desde que seguidas as recomendações 

prescritas no Manual de utilização. 

 

 

 

 

 

 

mailto:sac@bramsys.com.br
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6. SÍMBOLOS 

 

 

Frágil, manusear com cuidado 
 

Cuidado! Consultar documentos 

acompanhantes 

 

Para cima 

 

Empilhamento máximo 

 

Manter afastado de luz solar 

 

Manter seco 

 

Limites de temperatura 
 

Não estéril 

 

7. TERMO DE GARANTIA 

 

A Bramsys Indústria e Comércio Ltda. garante a seus clientes usuários originais que os equipamentos de 

sua fabricação são produzidos dentro da mais avançada tecnologia e com rigoroso controle de qualidade, 

assegurando, dentro das condições e prazos abaixo, seu perfeito funcionamento. 

 

DA GARANTIA 

A garantia, sem qualquer ônus ao usuário adquirente, é limitada à substituição e/ou conserto de eventuais 

peças defeituosas ou à correção de qualquer defeito de produção, mediante a constatação por nossa 

assistência técnica. 

 

A substituição e/ou conserto referido no item anterior não se aplica às peças com desgaste natural de uso, 

bem como por imperícias ou negligências na utilização do equipamento, ou ainda, que tenham sido 

consertadas ou modificadas por pessoas não credenciadas pela Bramsys. 

 

Em nenhuma hipótese, caso ocorra a necessidade de substituição de qualquer componente coberto por 

este termo, o período de garantia será dilatado pelo acréscimo de eventuais suplementares do componente 

substituído. 

 

DOS EQUIPAMENTOS 

Esta garantia é válida para todos os equipamentos da marca Bramsys produzidos pela Bramsys Indústria 

e Comércio Ltda. 

 

DA INSTALAÇÃO E DO USO 

A instalação e/ou operação dos equipamentos, bem como as condições de trabalho, devem atender às 

normas da Bramsys contidas neste Manual de utilização. Diferentes condições das indicadas invalidam as 

cláusulas de garantia deste termo. 

 

DO LOCAL DA GARANTIA 

O reparo do equipamento será realizado em nossas instalações. O frete do transporte (ida e volta) correrá 

por conta do adquirente usuário. 

 

DOS PRAZOS 

Inicia-se a partir da data de emissão da nota fiscal de venda da Bramsys ou seus revendedores, sendo 

válida para o equipamento pelo prazo de 12 meses, e o prazo de garantia dos acessórios é determinado 

pela vida útil ou noventa (90) dias, sendo considerado o que vencer primeiro. 
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DA RESPONSABILIDADE 

Esta garantia é válida somente para o equipamento que estiver em uso e na posse do adquirente usuário 

original. A responsabilidade da Bramsys é limitada à substituição e/ou reparo dos componentes, 

excetuando-se da garantia eventuais prejuízos por lucros cessantes ou pela indenização de quaisquer 

outros danos indiretos ou imediatos. 

 

Solicite a assistência técnica através do Serviço de Atendimento ao Consumidor (SAC) pelo telefone (11) 

5013-0010, ou pelo e-mail sac@bramsys.com.br. 

 

 

                                                                                                                                                                                        

mailto:sac@bramsys.com.br
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1. INTRODUCCIÓN 

 

El equipo de estereotaxia BMS-125E es un sistema que ayuda al neurocirujano a localizar blancos para la 

realización de procedimientos, como biopsias, drenaje de abscesos cerebrales, cirugías guiadas, drenaje y 

retirada de hematomas, implantación de isótopos para irradiación de adentro hacia afuera o intracavitalmente, 

aplicaciones en braquiterapia, cirugía para implantación de electrodos para estimulación (DBS) y lesión de 

estructuras encefálicas/cervicales. 

 

ATENCIÓN: este equipo sólo debe ser utilizado por un profesional médico apto. 

 

- El equipo de estereotaxia Bramsys BMS-125E es formado por los siguientes elementos: 

 

• 1 aro abierto 

• 4 barras de extensión 

• 4 tornillos fijadores de las barras de extensión 

• 4 adaptadores reductores de rosca 

• 4 llaves allen (2 de 4mm y 2 de 5mm) 

• 2 reglas milimetradas 

• 6 tornillos fijadores de la regla milimetrada 

• 1 arco graduado 

• 1 carro 

• 2 tubos milimetrados 

• 1 barra vertical "Z" larga 

• 1 guía de barra vertical "Z" larga 

• 1 barra vertical "Z" corta 

• 1 guía de barra vertical "Z" corta 

• 3 marcos de referencia para tomografía (2 laterales y 1 frontal grandes) 

• 3 marcos de referencia para tomografía (2 laterales y 1 frontal pequeños) 

• 6 tornillos de aluminio fijadores para los marcos de referencia 

• 1 segmento recto 

• 1 segmento curvo 

• 2 tornillos de aluminio fijadores para el segmento 

 

- Accesorios: 

 

• 2 a 3 cajas de almacenamiento 

• 1 tornillo de acero inoxidable de 30mm 

• 4 tornillos de acero inoxidable de 50mm 

• 4 tornillos de acero inoxidable de 75mm 

• 4 tornillos de acero inoxidable para niños de 75mm 

• 4 tornillos de acero inoxidable para niños de 90mm 

• 1 conjunto retractor isocéntrico (2 retractores isocéntricos y 6 espátulas) 

• 2 adaptadores universales de acero inoxidable 

• 2 brazos retractores de titanio 

• 2 brazos retractores de acero inoxidable 

• 1 fijador para niños (2 laterales y 1 frontal) 

• 2 alineadores de oído 

• 1 guía a láser 

• 3 bujes adaptadores reutilizables para biopsia 

• 3 bujes adaptadores reutilizables para cirugía guiada 

• 3 bujes adaptadores reutilizables para drenaje 

• 3 bujes adaptadores reutilizables para implantación de electrodos 
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• 3 marcos de referencia para resonancia magnética (1 frontal y 2 laterales) 

• 1 aro abierto de fibra de carbono 

• 1 segmento recto de fibra de carbono 

• 1 segmento curvo de fibra de carbono 

• 2 tornillos fijadores para los segmentos 

• 4 barras de extensión de fibra de carbono 

• 4 adaptadores reductores de rosca de fibra de carbono 

• 1 soporte para neuroendoscopio 

• 4 tornillos M8 de aluminio reutilizables de 30mm - adulto 

• 4 tornillos M8 de aluminio reutilizables de 50mm - adulto 

• 4 tornillos M8 de aluminio reutilizables de 75mm - adulto 

• 4 tornillos M8 de aluminio reutilizables de 50mm - infantil 

• 4 tornillos M8 de aluminio reutilizables de 75mm - infantil 

• 4 tornillos M8 de aluminio reutilizables de 90mm - infantil 

• 4 tornillos de acero inoxidable de 50mm - infantil 

• 4 tornillos M8 de titanio de 30mm - adulto 

• 4 tornillos M8 de titanio de 50mm - adulto 

• 4 tornillos M8 de titanio de 75mm - adulto 

• 4 tornillos M8 de titanio de 50mm - infantil 

• 4 tornillos M8 de titanio de 75mm - infantil 

• 4 tornillos M8 de titanio de 90mm - infantil 

• 4 tornillos M8 de plástico con punta de titanio de 30mm - adulto 

• 4 tornillos M8 de plástico con punta de titanio de 50mm - adulto 

• 4 tornillos M8 de plástico con punta de titanio de 75mm - adulto 

• 4 tornillos M8 de plástico con punta de titanio de 50mm - infantil 

• 4 tornillos M8 de plástico con punta de titanio de 75mm - infantil 

• 4 tornillos M8 de plástico con punta de titanio de 90mm - infantil 

• 4 tornillos M8 de plástico con punta de cerámica de 30mm 

• 4 tornillos M8 de plástico con punta de cerámica de 50mm 

• 4 tornillos M8 de plástico con punta de cerámica de 75mm 

• 4 tornillos M12 de plástico con punta de cerámica de 50mm 

• 4 tornillos M12 de plástico con punta de cerámica de 75mm 

• 4 tornillos M12 de plástico con punta de titanio de 50mm 

• 4 tornillos M12 de plástico con punta de titanio de 75mm 

• 1 juego de arco bilateral (2 semi arcos graduados, 1 carro, 1 tubo milimetrado, 1 barra vertical Z larga, 1 

guía de barra Z larga, 1 regla milimetrada) 

• 1 carro adaptador para microregistro (según el modelo de microregistro) 

• 1 apoyo para los marcos de referencia 

 

- Opcionales: 

 

• 1 adaptador para fijador craneal (según el modelo de fijador craneal) 

• 1 soporte fijador para mesa de tomógrafo (según el modelo de tomógrafo) 

• Software de planificación quirúrgica MNPS MEVIS 

Estuche para transporte 

 

2. INSTRUCCIONES PARA USO 

2.1 Cuidados iniciales 

• Al desempacar el equipo, asegúrese de que no haya daños aparentes causados por caídas o mal 

manejo durante el transporte. Si detecta algún daño aparente, comuníquese inmediatamente con el 

fabricante/representante para saber las medidas que debe implementar. 
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• Antes de comenzar el procedimiento, lubrique todas las partes deslizantes, las puntas de los tornillos de 

bloqueo del soporte de la regla milimetrada y el soporte de la barra vertical "Z", la parte inferior de las 

arandelas y la superficie de contacto del arco en el tubo milimetrado utilizando vaselina estéril o silicona. 

Esto permitirá que el esfuerzo para desenroscar o apretar los tornillos sea menor y, consecuentemente, la 

fijación sea beneficiada, además de prolongar el buen desempeño del equipo. 

 

2.2 Instalación 

• Examine todos los accesorios antes de comenzar la cirugía. Asegúrese de que estén funcionando 

correctamente. El armado incorrecto puede provocar el mal funcionamiento y efectos quirúrgicos 

indeseables. 

 

ATENCIÓN: Bramsys se responsabiliza por la seguridad, confiabilidad y desempeño de este equipo 

siempre que sea utilizado obedeciendo a las instrucciones para uso descritas en este manual. 

 

2.3 Fijación del aro en el paciente 

• Posición del blanco 

1. Verifique la posición del blanco realizando un estudio previo antes de fijar el aro en el paciente; 

 

2. Coloque el aro por encima o por debajo de la región de interés, nunca a la misma altura, ya que eso 

impedirá su visualización; 

 

3. Enrosque los tornillos directamente en el aro o en las barras de extensión con los adaptadores de 

rosca. 

 

ATENCIÓN: elija la longitud de los tornillos según el tamaño de la cabeza del paciente, asegurándose 

de que el tornillo no vaya más allá de los paralelos del aro. 

 

• Fijación con 3 tornillos 

 

Para la fijación con 3 tornillos, utilice 1 tornillo pequeño o medio frontal y 2 traseros. Si utiliza la regla 

milimetrada en la parte frontal del arco estereotáxico, utilice únicamente el tornillo pequeño frontal, para 

no superar la superficie recta del aro. 

 

 

 

                                  
 

 

 

 

Tornillo frontal 
 

Tornillo trasero 
 

Tornillo trasero 
 

Regla milimetra 
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• Fijación con 4 tornillos 

 

Para la fijación con 4 tornillos, utilice 2 tornillos frontales y 2 tornillos traseros. Si utiliza la regla milimetrada 

en la parte frontal del arco estereotáxico, asegúrese de que los tornillos frontales no vayan más allá de la 

superficie recta del aro. 

 

 

 

 
                                                    

 

 

 

Nota: los tornillos se registran y se venden por separado. 

 

 

• Fijación con barras de extensión 

 

Hay 4 barras de extensión intercambiables, que deben usarse cuando la fijación directa del arco 

estereotáxico en el cráneo del paciente dificulta la visualización del área del blanco. 

Fije las barras de extensión en el arco estereotáxico utilizando los tornillos correspondientes, con ayuda 

de la llave allen n.º 4. 

 

 

 
 

 

 

 

 

 

Tornillo frontal 
 

Tornillo frontal 
 

Regla milimetra 
 

Tornillo 

Barra de extensión 

Tornillo trasero 
 

Tornillo trasero 
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• Adaptadores reductores de rosca 

Cuando utilice la barra de extensión, coloque los adaptadores reductores de rosca, enroscándolos desde 

el lado interno de las barras. 

 

 

 

               
 

2.4 Armado de los segmentos 

1. La necesidad de armar el segmento curvo o el recto deberá ser evaluada por el responsable de la 

cirugía y del armado, buscando aumentar el campo de trabajo. 

 

2. El reemplazo del segmento recto por el curvo se realiza aflojando los tornillos fijadores, 

reemplazando las piezas y volviendo a apretar los tornillos, haciendo que el conjunto quede rígido. Para 

este armado se debe utilizar la llave allen n.º 5. 

                                

       

        

            
                               Segmento recto                                Segmento curvo  

 
 

2.5 Preparación para la tomografía 

• Armado del soporte en la mesa del tomógrafo 

 

1. Fije el soporte a la mesa del tomógrafo; 

 

  Adaptador reductor de rosca 
 

Barra de extensión 

Tornillo 

Tornillo Tornillo 
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2. Con la traba libre, encastre el aro en el soporte moviéndolo hasta encontrar la posición más cómoda 

para el paciente; 

 

3. Bloquee el soporte del aro con la palanca de plástico y fije el aro en el soporte con los dos tornillos 

de aluminio. 

Los tornillos que bloquean el aro siempre deben estar en posición contraria a los marcos de referencia, 

como muestran las figuras a continuación, evitando que el artefacto proveniente de la cabeza del tornillo 

aparezca en la imagen  

 

Armado de los marcos de referencia hacia arriba 

 

 
 

 

Armado de los marcos de referencia hacia abajo 

 

 
  

 

• Colocación de los marcos de referencia para tomografía en el aro 

 

Coloque los marcos de referencia (2 laterales y 1 frontal) en el arco estereotáxico, encastrándolos en los 

orificios correspondientes, siendo que el marco de referencia frontal se distingue por poseer un orificio en 

el centro y los marcos de referencia laterales deben estar siempre con la palabra "Occipital" en la parte 

posterior de la cabeza del paciente. Dependiendo de la posición del aro en la cabeza del paciente, los 

marcos de referencia se pueden colocar "UPWARD" (hacia arriba) o "DOWNWARD" (hacia abajo). 

ATENCIÓN: cuando utilice las barras de extensión, la posición de los marcos de referencia debe ser 

siempre "UPWARD". 

Tornillo 

Tornillo en posición contraria al 
marco de referencia 

 

Tornillo en posición contraria al 
marco de referencia 

 

Tornillo 

Marco de 
referencia 

Marco de 
referencia 
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UPWARD 

 

DOWNWARD 

 
 

 

       
 

ATENCIÓN: el armado incorrecto de los marcos de referencia provocará errores de cálculo de las 

coordenadas de estereotaxia. 

 

• Cálculo de coordenadas con el software MNPS 

 

Conversión de imágenes DICOM a IMG 

1. Inserte el CD con las imágenes estereotáxicas de la tomografía en la computadora; 

2. Copie las imágenes al directorio MNPS/DICOM; 

3. Abra el directorio de TAC; 

4. Arrastre cualquier imagen sobre el icono CT MevDICOM; 

5. Muestre 12 imágenes con el cuarto botón; 

6. Ordene las imágenes usando el camino de menú Options → Sort images → z (transversal); 

7. Recorte un cuadro que incluya los marcos de referencia (use el quinto botón); 

8. Haga doble clic en el cuadro rojo; 

9. Deshabilite las imágenes que son Scout View (vista de explorador) o con marcos de referencia 

unidos usando la tecla Space; 

10. Vaya a File → Export to img o apriete el segundo botón (Guardar); 

11. Responda Yes a la pregunta de abrir el MNPS. 

 

Preparación de la planificación del procedimiento 

1. Elija la posición de los marcos de referencia Upward o Downward utilizada por el software; 

2. Elija la posición de la marca (right, left, frontal, occipital); 

3. Seleccione el tipo de aro que utilizará; 

4. Inspeccione corte por corte si los marcos de referencia encontrados automáticamente están 

correctos, navegando por las imágenes con la tecla Enter; 

5. En la ventana mosaico (donde aparecen 9 imágenes juntas) haga doble clic en cualquiera de ellas 

para ir a la ventana principal de MNPS; 

6. Ya en la ventana principal, vaya a un corte que esté aproximadamente a la altura del tumor (biopsias) 

o a la altura en la unión del tercer ventrículo (funcional); 

Marco de referencia 
para Tomografia 
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7. Ajuste la ventana con el botón derecho del ratón sobre la imagen principal; 

8. Para un ajuste más preciso del contraste de la imagen, haga clic en el botón de brillo y contraste y, 

con las flechas del teclado, mueva los niveles mirando el histograma a la derecha de la pantalla. 

 

Definición de coordenadas estereotáxicas en caso de biopsia 

1. Vaya al nivel de un corte aproximadamente en el centro del tumor; 

2. Haga zoom sobre la lesión; 

3. Empiece a dibujar el perímetro del tumor. Para ello, haga clic en el botón ROI Menu (el que tiene un 

lápiz y un papel verde), y haga clic en la opción Draw ROI Segment de ese menú. Después de elegir 

el número de ROI y escribir el nombre deseado, empiece a dibujar sobre la imagen. Recuerde que 

para borrar parte de un ROI puede utilizar el botón Delete; 

4. Cambie de corte y dibuja sobre otros cortes. Termine con el botón de lápiz; 

5. Guarde la planificación con el botón que tiene el dibujo de un disquete; 

6. Vaya nuevamente al menú de ROI (botón de lápiz y papel verde) y seleccione ROI center to POI 

para definir automáticamente un punto en el centro del tumor; 

7. Edite las coordenadas de ese punto usando el botón POI Table (o las teclas Control+End). Para 

visualizar la trayectoria, escriba en el campo FROM del punto central del tumor la palabra OUT y 

ajuste los ángulos deseados para la cánula de biopsia; 

8. Guarde la planificación y anote las coordenadas que se utilizarán en el equipo para la estereotaxia; 

9. Para visualizar la trayectoria elegida, utilice los cortes axiales, vistas en 3D, y también las vistas 

coronal y sagital. También se puede hacer un oblicuo; 

10. Para pasar de una vista a otra (coronal o sagital), se debe volver a la axial utilizando el botón Go to 

o el botón mosaico. 

 

Definición de las coordenadas estereotáxicas en caso de cirugía funcional 

1. Vaya al nivel de AC y marque AC usando el botón POI. Haga lo mismo para PC y para IHP; 

2. Reconstruya las imágenes paralelas al plano AC-PC con Alt-F6; 

3. Modifique la posición de los puntos AC y PC a voluntad y reconstruya nuevamente con Alt-F6; 

4. Mida la distancia entre los puntos AC y PC utilizando la combinación Control+D. Debe tener 

alrededor de 26mm en una anatomía normal; 

5. Verifique la posición lateral del IHP observando la simetría de la anatomía a la altura del tramo de 

las órbitas, en planos paralelos AC-PC; 

6. Reconstruya planos inclinados a 7 grados con respecto al plano de AC-PC utilizando la combinación 

Shift-F6; 

7. Active el atlas usando el botón atlas; 

8. Verifique si el atlas coincide con la anatomía en las regiones cercanas al tercer ventrículo y al 

acueducto cerebral; 

9. Si no coincide, vuelva al plano AC-PC y modifique el punto AC o PC; 

10.  Sitúe la estructura del blanco y coloque un PDI dentro de ella; 

11.  Edite el cuadro de POIs usando el botón POI Table, registrando las coordenadas del blanco (GPI, 

etc.) que se utilizarán en el equipo de Estereotaxia; 

12.  Para capturar imágenes de la planificación, utilice la combinación Alt-C. 

 

Fusionar imágenes 

Si las estructuras que serán trabajadas no están bien definidas en la tomografía, puede utilizar el recurso 

de fusión de imagen con la resonancia magnética. 

1. Inserte las imágenes en el filtro DICOM para MRI y anote el nombre del paciente, indicando la 

orientación de las imágenes (coronal, sagital o axial); 

2. Ordene las imágenes; 

3. Guarde las imágenes; 

4. Salga del filtro DICOM; 

5. En MNPSShell, abra Planning → CAT3D for Fusion; 

6. En CAT3DShell, abra CAT3D y cargue la información/imágenes del paciente (MRI) con Load 

Anatomy - Start New Patient; 
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7. Haga doble clic en una imagen del mosaico; 

8. Obtenga 4 puntos, por ejemplo, OD, OI, Fast y T; 

9. Guarde la planificación; 

10. Presione ESC, vaya al menú de inicio de CAT3D y seleccione Export Fusion; 

11. Vuelva al Windows con la tecla de Windows y seleccione la ventana; 

12. En MNPS, utilizando TAC, marque los mismos 4 puntos con los mismos 4 nombres; 

13. Presione el botón de Fusión y elija el paciente (axial, coronal o sagital); 

14. Utilizando la combinación Control+F5, mueva la ventana de la resonancia; 

15. Comience la maximización de la información mutua utilizando la combinación Alt+F5; 

16. Verifique la posición del blanco y los puntos base; 

17. Salga de la fusión con el mismo botón de fusión; 

18. Vea el atlas en CT usando Shift+F6 y reajuste AC-PC; 

19. Localice el blanco que se lesionará y anote las coordenadas que se utilizarán en el equipo para la 

estereotaxia; 

20. Guarde la planificación y cierre el sistema; 

21. Recomendamos hacer una copia de seguridad de las imágenes y la información del paciente. 

 

2.6. Armado y verificación del equipo de estereotaxia 

 

ATENCIÓN: todas las piezas deben deslizarse fácilmente entre sí. 

Si hay alguna resistencia, compruebe si la pieza está correctamente armada, encastrada o si algún tornillo 

fijador está causando interferencia. 

Si el problema persiste, comuníquese con el sector de Soporte Técnico de Bramsys. 

 

• Armado del carro y de los adaptadores 

 

Coloque los adaptadores en el carro y la guía regulable como sigue: coloque los dos adaptadores más 

largos en la parte graduada del carro y el más pequeño en la parte inferior de la guía regulable. 

El adaptador más largo tiene una marca que indica la posición del orificio para fijar la cánula usando el 

perno de bloqueo del carro. 

 

Nota: los adaptadores se registran y se venden por separado. 

 

 

 

                

 

 

Adaptador 

Bloqueo del movimiento 
± z del carro 
 

Marca de punto cero del carro 

Guia 

Adaptadores 



 

 32  

 

• Armado del instrumental 

 

Inserte la cánula o el electrodo en el carro hasta el final de su recorrido, donde la base toca en el adaptador. 

Nota: las cánulas y los electrodos se registran y se venden por separado. 

 

 

 

• Mira para el control del isocentro 

 

Verifique la calibración del instrumental, es decir, si está en el isocentro, de la siguiente manera: 

1. Arme el conjunto del tubo milimétrico, el arco y el carro; 

2. Ajústelo en el equipo de estereotaxia usando las coordenadas obtenidas de la planificación 

quirúrgica; 

3. Inserte la cánula o el electrodo con el carro en la posición "0" (cero); 

4. Alinee los dos extremos de la mira mirando por el tubo milimetrado; 

5. Ajuste el área de interés en la cánula o el electrodo para que quede colocada en el centro de la mira 

del tubo milimetrado; 

6. Apriete todos los tornillos de bloqueo de movimiento para asegurarse de que las coordenadas 

ajustadas permanezcan correctas; 

7. Complemente el armado del arco y el carro en el arco estereotáxico y realice el procedimiento. 

 

 

 
 

2.7 Uso de adaptador para fijadores craneales 

1. Coloque el adaptador en el arco estereotáxico y fíjelo correctamente; 

2. Ajuste el fijador craneal, eligiendo la posición ideal para el procedimiento. 

Instrumental 

Carro 

Adaptador 

Tubo 
Milimetrado 
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2.8 Escalas 

Todas las escalas están en milímetros (mm) y los ángulos en grados sexagesimales. 

2.9 Tolerancia 

La precisión de las coordenadas del equipo es de ± 0,5mm. 

2.10 Esterilización 

El equipo de estereotaxia se puede esterilizar con óxido de etileno, peróxido de hidrógeno o autoclave a 

vapor (necesita una caja de almacenamiento especial), de acuerdo con la información del cuadro a 

continuación: 

 

Método Parámetros de esterilización Observaciones 

Óxido de etileno (ETO) 2 a 3 horas entre 50 y 60°C. 

Después de esterilizado, el 

equipo debe pasar por aireación 

mecánica durante 240 minutos o 

aireación ambiental durante 24 a 

72 horas. 

Peróxido de hidrógeno 

(STERRAD) 
Aproximadamente 75 minutos. - 

Autoclave a vapor (necesita 

caja de almacenamiento 

especial) 

Aproximadamente 1 hora y 15 

minutos a 134°C. 

No esterilice en ciclos rápidos o 

con temperaturas superiores a 

150°C. 

 

 

No utilice el método de autoclave a vapor en los accesorios a continuación: 

- Tornillos de plástico con punta de titanio, tornillos de plástico con punta de cerámica, marcos de referencia 

para resonancia magnética. 

 

 

3. PRECAUCIONES, RESTRICCIONES, ADVERTENCIAS Y CUIDADOS ESPECIALES 

 

3.1 Precauciones 

No utilice el equipo y los accesorios después de su vida útil. Puede ocurrir un mal funcionamiento de los 

productos, dificultando el trabajo del usuario y/o causando daños al paciente. Aunque el equipo no utiliza 

artículos desechables ni genera residuos después de su uso, después de la vida útil, éste debe ser 

separado para una posible revalidación o descarte de acuerdo con la legislación local vigente. 

3.2 Restricciones 

• Todas las piezas y accesorios pertenecientes al equipo son de uso exclusivo con este. 

• Recomendamos los productos a continuación para uso en combinación con el modelo BMS-125E: 

Cánulas para estereotaxia Bramsys 

Adaptadores Bramsys 

Tornillos Bramsys 

Electrodos para cirugía funcional Bramsys 

 

ATENCIÓN: el uso de cualquier parte, accesorio o material no especificado es responsabilidad exclusiva 

del usuario. 
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3.3 Avisos y advertencias 

• Evite la caída, torsión, aplastamiento, impacto, o acción que pueda deformar el equipo. 

• Deformaciones en la estructura del equipo comprometen su precisión, pudiendo generar daños al paciente. 

• Fije adecuadamente las partes móviles del equipo. 

• Movimientos de las coordenadas estereotáxicas resultantes de desplazamiento accidental de esas partes 

alterarán la posición del objetivo predeterminado, pudiendo ocasionar daños al paciente. 

• El equipo debe ser limpiado y esterilizado correctamente siguiendo las instrucciones presentes en el manual 

del usuario, de lo contrario habrá posibilidad de contaminación bacteriana y/o viral, pudiendo causar 

complicaciones infecciosas al paciente. 

• El esfuerzo excesivo en la fijación del arco estereotáxico en el cráneo, superando la fuerza soportada por la 

estructura ósea, podrá ocasionar lesiones en el paciente. 

• La lectura inadecuada de las escalas del equipo, por error de interpretación del usuario o por desgaste de 

la pintura en las escalas, puede provocar error en la ejecución del procedimiento, pudiendo ocasionar daños 

al paciente.. 

 

 

4. ALMACENAMIENTO, LIMPIEZA, CONSERVACIÓN Y TRANSPORTE 

 

4.1 Almacenamiento 

• Mantenga el equipo en su envase original, en un local protegido de la humedad excesiva, la lluvia y el sol 

directo. 

4.2 Limpieza y desinfección 

• Para la limpieza externa del aparato después de cada procedimiento, utilice solamente jabón neutro y agua 

tibia. Para secarlo, utilice preferiblemente aire comprimido o un paño seco limpio. 

• No utilice disolventes orgánicos como thinner ni detergentes que contengan disolventes, como éter, 

removedor, gasolina, etc. para limpiar el equipo. No utilice aerosoles ni aplicadores a base de spray líquido. 

• No utilice material micro abrasivo ni lana de acero para la limpieza. 

• También lave la caja con una esponja suave o un paño húmedo con agua y jabón suave y séquela después 

del lavado. 

4.3 Lubricación 

• Lubrique todas las piezas deslizantes, las puntas de los tornillos de bloqueo del soporte de la regla lateral 

milimetrada y del soporte de la barra vertical "Z", la parte inferior de las arandelas y la superficie de contacto 

del arco con el tubo milimetrado utilizando silicona o vaselina estéril antes de comenzar el procedimiento. 

4.4 Conservación 

• Mantenga el equipo limpio y seco para el próximo uso. 

• Manténgalo en local limpio y alejado del polvo. 

4.5 Transporte 

• Evite vibraciones e impactos y no deje que el equipo caiga al suelo. 

• No permita que el equipo quede expuesto a la lluvia o la humedad excesiva. 

• Todas las piezas deben ser colocadas dentro de la caja de transporte. 

• Asegúrese de que todas las piezas estén colocadas y fijadas correctamente en su lugar. 
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5. DESCRIPCIÓN DE LA EFICACIA Y SEGURIDAD DEL PRODUCTO 

 

5.1 Efectos secundarios o colaterales indeseables y contraindicaciones 

 

• Este equipo no produce ningún efecto secundario o efectos colaterales indeseables si se toman todas las 

recomendaciones descritas en este documento. El equipo no tiene contraindicaciones. Solo puede ser 

utilizado u operado por un profesional médico especializado o supervisado por un profesional apto. 

5.2 Mantenimiento preventivo 

 

• Para garantizar el buen funcionamiento y la seguridad del equipo, envíelo a Bramsys anualmente para 

realizar el mantenimiento preventivo. 

5.3 Mantenimiento correctivo 

 

• Si ocurre algún problema con el equipo o sus piezas, envíelos a Bramsys con la descripción del problema. 

ATENCIÓN: solicite soporte técnico comunicándose con el Servicio de Atención al Consumidor (SAC) por 

el teléfono +55 (11) 5013-0010 o por el correo electrónico sac@bramsys.com.br. 

5.4 Descripción de la seguridad y la eficacia 

 

• La seguridad y la eficacia en el uso del equipo se logran siempre que sean respetadas las recomendaciones 

prescritas en el Manual de uso correspondiente. 

 

 

6. SÍMBOLOS 

 

 

Frágil, manejar con cuidado  
 

¡Cuidado! Consultar documentos 

adjuntos 

 

Colocar hacia arriba  

 

Apilado máximo  

 

Mantener alejado de la luz solar  

 

Mantener seco  

 

Límites de temperatura  
 

No estéril  

 

7. CONTRATO DE GARANTIA 

 

Bramsys Industria e Comércio Ltda. garantiza a sus clientes usuarios originales que los equipos de su 

fabricación son producidos utilizando tecnología de vanguardia y tienen riguroso control de calidad, 

asegurando, dentro de las condiciones y plazos abajo, su perfecto funcionamiento. 

 

GARANTÍA  

La garantía, sin ninguna carga para el usuario adquirente, queda limitada al reemplazo y/o la reparación de 

eventuales piezas defectuosas o la corrección de cualquier defecto de producción, después de previa 

constatación por nuestro sector de soporte técnico. 

 

mailto:sac@bramsys.com.br
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El reemplazo y/o la reparación mencionados en el ítem anterior no se aplican a piezas con desgaste natural 

resultante del uso, así como de impericias o negligencias en la utilización del equipo, o aún, que hayan sido 

arregladas o modificadas por personas no autorizadas por Bramsys. 

 

En caso de necesidad de reemplazo de cualquier componente cubierto por este término, el período de 

garantía no será ampliado en ninguna circunstancia por la adición de eventuales repuestos del componente 

reemplazado. 

 

EQUIPOS 

Esta garantía es válida para todos los equipos de la marca Bramsys fabricados por Bramsys Indústria e 

Comércio Ltda. 

 

INSTALACIÓN Y USO 

La instalación y/u operación de los equipos, así como las condiciones de trabajo, deben cumplir con las 

normas de Bramsys descritas en este Manual de uso. Condiciones diferentes de las indicadas invalidarán 

las cláusulas de garantía de este contrato. 

 

LOCAL DE LA GARANTÍA 

La reparación del equipo se realizará en nuestras instalaciones. El flete del transporte (ida y vuelta) quedará 

a cargo del usuario adquirente. 

 

PLAZOS 

Comienza a partir de la fecha de emisión de la factura de venta de Bramsys o sus revendedores, teniendo 

validez para el equipo durante un plazo de 12 meses, y el plazo de garantía de los accesorios es 

determinado por la vida útil o 90 (noventa) días, siendo considerado el plazo que vence primero. 

 

RESPONSABILIDAD 

Esta garantía es válida solamente para el equipo que esté en uso y en posesión del usuario adquirente 

original. La responsabilidad de Bramsys queda limitada al reemplazo y/o la reparación de los componentes, 

a excepción de la garantía de posibles pérdidas por lucro cesante o por la indemnización de cualquier otro 

daño indirecto o inmediato. 

 

Solicite soporte técnico comunicándose con el Servicio de Atención al Consumidor (SAC) por el teléfono 

+55 (11) 5013-0010, o por el correo electrónico sac@bramsys.com.br. 
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1. INTRODUCTION  

 

The BMS-125E stereotaxic apparatus system was designed to assist the neurosurgeon in locating targets for 

performing procedures such as biopsies, brain abscess drainage, guided surgeries, hematoma drainage and 

removal, isotope implantation for inside-out or intracavitary irradiation, applications in brachytherapy, 

electrodes implantation for stimulation (DBS), and surgeries involving encephalic/cervical structural injuries. 

 

ATTENTION: this equipment should only be used by a specialized medical professional. 

 

− The Bramsys BMS-125E stereotaxic apparatus consists of the following items: 

 

• 1 open frame 

• 4 extension bars 

• 4 extension bar fixing screws 

• 4 thread reducer adapters 

• 4 allen keys (2 of 4mm/2 of 5mm) 

• 2 millimeter rulers 

• 6 millimeter ruler fixing screws 

• 1 graduated arch 

• 1 trolley 

• 2 millimeter tubes 

• 1 long “Z” vertical bar 

• 1 long “Z” vertical bar guide 

• 1 short “Z” vertical bar 

• 1 short “Z” vertical bar guide 

• 3 tomography benchmarks (2 lateral and 1 frontal, both large) 

• 3 tomography benchmarks (2 lateral and 1 frontal, both small) 

• 6 aluminum screws for fixing the benchmarks 

• 1 straight segment 

• 1 curved segment 

• 2 aluminum screws for fixing the segments 

 

− Accessories: 

 

• 2 to 3 storage boxes 

• 1 30mm stainless steel screw 

• 4 50mm stainless steel screws 

• 4 75mm stainless steel screws 

• 4 75mm pediatric stainless steel screws 

• 4 90mm pediatric stainless steel screws 

• 1 set of isocentric retractor (2 isocentric retractors and 6 spatulas) 

• 2 stainless steel universal adapter  

• 2 titanium retractor arms 

• 2 stainless steel retractor arms 

• 1 pediatric fixture (2 lateral and 1 frontal) 

• 2 ear aligners 

• 1 laser guide 

• 3 reusable bushing adapters for biopsy 

• 3 reusable bushing adapters for guided surgery 

• 3 reusable bushing adapters for drainage 

• 3 reusable bushing adapters for electrode implantation 

• 3 MRI benchmarks (1 frontal and 2 lateral) 
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• 1 open carbon fiber frame 

• 1 carbon fiber straight segment  

• 1 carbon fiber curved segment 

• 2 segment fixing screws 

• 4 carbon fiber extension bars 

• 4 carbon fiber thread reducer adapters  

• 1 neuro endoscope holder 

• 4 reusable 30mm M8 aluminum screws - adult 

• 4 reusable 50mm M8 aluminum screws - adult 

• 4 reusable 75mm M8 aluminum screws - adult 

• 4 reusable 50mm M8 aluminum screws - pediatric 

• 4 reusable 75mm M8 aluminum screws - pediatric 

• 4 reusable 90mm M8 aluminum screws - pediatric 

• 4 50mm stainless steel screw - pediatric 

• 4 30mm titanium M8 screws - adult 

• 4 50mm titanium M8 screws - adult 

• 4 75mm titanium M8 screws - adult 

• 4 50mm titanium M8 screws - pediatric 

• 4 75mm titanium M8 screws - pediatric 

• 4 90mm titanium M8 screws - pediatric 

• 4 30mm plastic M8 screws with titanium tip - adult 

• 4 50mm plastic M8 screws with titanium tip - adult 

• 4 75mm plastic M8 screws with titanium tip - adult 

• 4 50mm plastic M8 screws with titanium tip - pediatric 

• 4 75mm plastic M8 screws with titanium tip - pediatric 

• 4 90mm plastic M8 screws with titanium tip - pediatric 

• 4 30mm plastic M8 screws with ceramic tip 

• 4 50mm plastic M8 screws with ceramic tip 

• 4 75mm plastic M8 screws with ceramic tip 

• 4 50mm plastic M12 screws with ceramic tip 

• 4 75mm plastic M12 screws with ceramic tip 

• 4 50mm plastic M12 screws with titanium tip 

• 4 75mm plastic M12 screws with titanium tip 

• 1 Bilateral arch set (2 half-graduated arches, 1 trolley, 1 millimeter tube, 1 long Z vertical bar, 1 long 

Z bar guide, 1 millimeter ruler) 

• 1 adapter trolley for microregistration (according to the microregister model) 

• 1 benchmark holder 

 

− Optional parts: 

 

• 1 cranial fixture adapter (as per the cranial fixture model) 

• 1 tomography table holder (as per the model of the tomograph) 

• MNPS MEVIS surgical planning software 

• Transport case 

 

 

2. INSTRUCTION FOR USE 

2.1 Initial Precautions  

• When unpacking the equipment, check that there is no apparent damage caused by dropping or improper 

handling during transport. If any damage is observed, please contact the manufacturer/representative 

immediately for the measures to be taken. 
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• Before starting the procedure, lubricate all parts that slide together, the ends of the locking screws of the 

millimeter side ruler holder and the vertical “Z” bar holder, the underside of the washers, and the contact 

surface of the arch on the millimeter tube using silicone or sterile Vaseline. This will allow less effort to 

loosen or tighten the screws and, consequently, the fixation will be improved, in addition to prolonging the 

good performance of the equipment. 

2.2 Installation 

 

• Examine all accessories before starting surgery. Make sure they are working correctly. Incorrect assembly 

can result in malfunctions and undesirable surgical effects. 

 

ATTENTION: Bramsys will be responsible for the safety, reliability, and performance of this equipment 

as long as it is used in accordance with the instructions for use provided in this manual. 

2.3 Attaching the frame to the patient 

 

• Target position 

 

1. Check the target position through a previous survey before fixing the frame to the patient. 

 

2. Position the frame above or below the region of interest, never at the same height, as this will prevent 

visualization. 

 

3. Thread the screws directly into the frame or extension bars using the thread adapters. 

 

WARNING: select the screw length according to the size of the patient’s head, making sure that the screw 

does not exceed the frame parallels. 

 

• Fixing with 3 screws 

 

For the 3-screw fixation, use 1 small or medium screw at the front and 2 at the rear. When using the 

millimeter ruler on the front of the stereotactic frame, use the small front screw only so that it does not 

exceed the straight surface of the frame. 

 

 

 

 

                                  
 

 

 

 

Frontal Screw 

Rear screw 
 

Rear screw 
 

Milimiter ruler 
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• Fixing with 4 screws 

 

For the 4-screw fixation, use 2 front screws and 2 rear screws. When using the millimeter ruler on the 

front of the stereotactic frame, make sure that the front screws do not go beyond the straight surface of 

the frame 

 

 

 
                                                    

 

 

 

 

             Note: screws are registered and sold separately. 

 

• Fixing with extension bars 

 

There are 4 interchangeable extension bars to be used when the fixing of the stereotactic frame directly 

to the patient’s skull hampers the target area visualization. 

Fix the extension bars to the stereotactic frame with Allen Key #4 using the corresponding screws. 

 

 
 

 

                                        

• Thread reducer adapters 

When using the extension bar, place the thread reducer adapters by threading them from the inside of 

the bars. 

 

 

Frontal Screw 
 

Frontal Screw 
 

Milimiter ruler 
 

Screw 

Extension bar 

Rear screw 
 

Rear screw 
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2.4 Assembling the segments 

1. The need to assemble the curved or straight segment to increase the working area must be evaluated 

by the person in charge of surgery and assembly. 

 

2. In order to replace the straight segment with the curved one, use the Allen Key #5 to loosen the fixing 

screws, replace the parts and tighten the screws again, making sure the assembly is properly rigid. 

                                

       

        

            
                                  Straight segment                                  Curved segment  

 
 

2.5 Preparation for tomographic study 

• Mounting the holder on the tomograph table 

 

1. Fix the holder on the tomograph table. 

 

2. After unlocking the latch, fit the frame to the holder, moving it until you find the most comfortable 

position for the patient. 

 

3. Lock the frame holder with the plastic lever and attach the frame to the holder with the two aluminum 

screws. 

Thread reducer adapter 
 

Extension bar 
 

Screw 

Screw Screw 
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The screws that lock the frame into place must always be in the opposite position to the benchmarks, as 

shown in the figures below, thus preventing the artifact from the screw head from being produced in the 

image. 

 

Upward Mounting of the Benchmarks 

 

 
 

 

 

Downward Mounting of the Benchmarks 

 

 
  

 

 

• Placing the tomography benchmarks on the frame 

 

Place the benchmarks (2 lateral and 1 frontal) on the stereotactic frame, fitting them into the corresponding 

holes, with the frontal benchmark being distinguished by having a hole in the center and the lateral ones having 

the word “Occipital” in the back of the patient’s head. According to the positioning of the frame on the patient’s 

head, the benchmarks can be placed “UPWARD” or “DOWNWARD”. 

WARNING: when using the extension bars, the position of the benchmarks should always be “UPWARD.” 

 

 

 

 

 

Screw 

Screw mounted opposite to the benchmark 
 

Screw mounted opposite to the benchmark 
 

Screw 

Reference 

Reference 
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UPWARD 

 

DOWNWARD 

 
 

 

        
 

WARNING: incorrect assembly of the benchmarks leads to errors in the calculation of stereotactic coordinates. 

 

• Calculation of coordinates with the MNPS software 

 

Converting DICOM images to IMG 

1.     Insert the CD with the tomograph stereotactic images into the PC. 

2. Copy them to the MNPS/DICOM directory. 

3. Open the TAC directory; 

4. Drag any image over the CT MevDICOM icon. 

5. Show 12 images with the fourth button. 

6. Sort the images from the menu Options → Sort images → z (transversal). 

7. Cut a frame in which the benchmarks are included (use the fifth button). 

8. Double-click on the red frame. 

9. Deactivate the Scout View images or those with linked benchmarks by using the Space key. 

10. Go to File → Export to IMG or press the second button (Save). 

11. Answer Yes to the prompt to open the MNPS. 

 

Preparation of procedure planning 

1. Select the Upward or Downward benchmark positions to be used by the software. 

2. Select the marking position (right, left, frontal, occipital). 

3. Select the type of frame to be used. 

4. Perform a section-by-section inspection to check if the automatically found benchmarks are correct, 

approving the image with the Enter key. 

5. In the mosaic window (where 9 images appear together), double-click on any one of them to go to 

the main MNPS window. 

6. In the main window, go to a section that is approximately at the height of the tumor (biopsies) or at 

the height of the third ventricle junction (functional). 

7. Adjust the window using the right mouse button on the main image. 

8. For a finer tuning of the image contrast, click on the brightness and contrast button and, with the 

keyboard arrows, move the histogram levels on the right of the screen. 

Tomography 
benchmarks 
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Definition of stereotactic coordinates in case of biopsy 

1. Go to the level of a section approximately in the center of the tumor. 

2. Zoom in on the lesion. 

3. Start drawing the tumor perimeter. For such, click on the ROI Menu button (the one with a pencil and 

green paper) and then on the Draw ROI Segment option on that menu. After choosing the ROI 

number and writing its name, start drawing over the image. Remember that you can use the Delete 

button to delete part of an ROI. 

4. Change sections and draw over other sections. Finish with the pencil button. 

5. Save the planning by clicking on the button with the floppy disc icon. 

6. Go to the ROI Menu again (pencil and green paper button) and select ROI center to POI to 

automatically set a point at the center of the tumor. 

7. Using the POI Table button (or the Control+End keys), edit the coordinates of that point. To visualize 

the trajectory, write the word OUT in the FROM field of the central point of the tumor and adjust the 

desired angles for the biopsy cannula. 

8. Save the planning and write down the coordinates to be used in the Stereotactic Apparatus. 

9. To visualize the chosen trajectory, use the axial sections, visualize in 3D, and also in coronal and 

sagittal planes. You can also do an oblique plane visualization. 

10. To switch from one view to another (coronal or sagittal), return to the axial view using the Go to 

button or the mosaic button. 

 

Definition of stereotactic coordinates in case of functional surgery 

1. Go to the AC level and check AC with the POI button. Do the same for PC and for IHP. 

2. Rebuild the images parallel to the AC-PC plane with Alt-F6. 

3. Modify the position of the AC and PC points at will or rebuild them with Alt-F6. 

4. Measure the distance between the AC and PC points with the Control+D keys. It should be around 

26 mm in normal anatomy. 

5. Check the lateral position of the IHP by observing the anatomy symmetry at the ocular orbit height 

in AC-PC parallel planes. 

6. Rebuild planes inclined at 7 degrees in relation to the AC-PC plane using Shift-F6. 

7. Activate the atlas using the atlas button. 

8. Check that the atlas matches the anatomy in the regions close to the third ventricle and the cerebral 

aqueduct. 

9. If it does not, go back to the AC-PC plane and modify the AC or PC point. 

10.  Locate the target structure and place a POI within it. 

11.  Edit the POI table using the POI Table button, registering the coordinates of the target point (GPI 

etc.) that will be used in the Stereotactic Apparatus. 

12.  To capture the planning images, use Alt-C. 

 

Image fusion 

If the structures to be worked on are poorly defined in the tomography, the image fusion with the magnetic 

resonance can be used. 

1. Insert the images in the DICOM filter for MRI and write down the patient’s name, indicating the 

orientation of the images (coronal, sagittal, or axial). 

2. Sort the images. 

3. Save the images. 

4. Exit the DICOM filter. 

5. In MNPSShell, open Planning → CAT3D for Fusion. 

6. In CAT3DShell, open CAT3D and load the patient information/images (MRI) with Load Anatomy – 

Start New Patient. 

7. Double-click on a mosaic image. 

8. Mark 4 points, for example, OD, OI, Fast, and T. 

9. Save the planning. 

10. Go to CAT3D’s start menu using the ESC key and select Export Fusion. 
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11. Return to Windows with the Windows key and select the window. 

12. In MNPS, with the TAC, mark the same 4 points with the same 4 names. 

13. Press the Fusion button and choose the patient (axial, coronal, or sagittal). 

14. Move the resonance window with the Control+F5 keys. 

15. Start the mutual information maximization with the Alt+F5 keys. 

16. Check target point position and base points. 

17. Exit fusion using the same button. 

18. Visualize the atlas in CT with Shift+F6 and reset AC-PC. 

19. Locate the target to be injured and write down the coordinates to be used in the Stereotactic 

Apparatus. 

20. Save the planning and close the system. 

21. We recommend backing up patient images and information. 

 

2.6 Assembly and verification of the stereotactic apparatus 

 

WARNING: all parts should slide easily against each other. 

If there is any resistance, check if the part is correctly mounted, fitted, or if any fixing screws are causing 

interference. 

If the problem persists, please contact Bramsys’ technical assistance. 

 

• Trolley and adapters assembly 

 

Mount the adapters on the trolley and on the adjustable guide as follows: place the two longer adapters 

on the graduated part of the trolley and the shorter one on the underside of the adjustable guide. 

The longer adapter has an indication of the position of the hole for fixing the cannula through the trolley 

locking screw. 

Note: adapters are registered and sold separately. 

 

 

                

• Instrument assembly 

 

Insert the cannula or electrode into the trolley until the end of its course, where its base touches the adapter. 

Note: cannulas and electrodes are registered and sold separately. 

 

Adapter 

Trolley movement ± z lock 
 

Trolley zero point mark 
 

Guide 

Adapters 
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• Crosshairs for isocenter control 

 

Check if the instrument is properly calibrated at the isocenter, as follows: 

1. Mount the millimeter tube, arch, and trolley assembly. 

2. Adjust the coordinates from the surgical planning in the Stereotactic Apparatus. 

3. Insert the cannula or the electrode with the trolley in its “0” (zero) position. 

4. Align the two ends of the crosshair looking through the millimeter tube. 

5. Adjust the area of interest on the cannula or electrode so that it is positioned in the center of the 

millimeter tube crosshairs. 

6. Tighten all motion lock screws to ensure the adjusted coordinates remain correct. 

7. Complete the arch and trolley assembly on the stereotaxic frame and carry out the procedure. 

 

 
 

2.7  Use of the cranial fixture adapter 

 

1. Mount the adapter on the stereotactic frame and secure it properly. 

2. Adjust the cranial fixture, choosing the best position for the procedure. 

2.8 Scales 

All scales are in millimeters (mm) and angles in sexagesimal degrees. 

2.9 Tolerance 

The equipment coordinates accuracy is ± 0.5mm. 

Instruments 

Trolley 

Adapter 

Milimiter tube 
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2.10 Sterilization 

The stereotactic apparatus can be sterilized with ethylene oxide, hydrogen peroxide, or steam autoclave 

(requires a special storage box), according to the information in the table below: 

 

Method Sterilization Parameters Notes 

Ethylene oxide (ETO) 
2 to 3 hours, between 50 

and 60°C. 

After sterilization, the equipment 

must undergo mechanical aeration 

for 240 minutes or environmental 

aeration for 24 to 72 hours. 

Hydrogen peroxide 

(STERRAD) 
Approximately 75 minutes. - 

Steam autoclave (requires 

special storage box) 

Approximately 1 hour and 

15 minutes at 134°C. 

Do not sterilize on rapid cycles or 

above 150°C. 

 

 

Do not use the steam autoclave method on the following accessories: 

- Plastic screws with titanium tip, plastic screws with ceramic tip, MRI benchmarks. 

 

 

 

3. PRECAUTIONS, RESTRICTIONS, WARNINGS, AND SPECIAL CARE 

3.1 Precautions 

Do not use the equipment and its accessories after their validity period. They may malfunction, making 

the user’s work difficult and/or causing harm to the patient. Although not using disposable items or 

generating waste after use, the equipment must be segregated for possible revalidation or discarded in 

accordance with current local legislation at the end of its useful life. 

3.2 Restrictions 

• All parts and accessories accompanying the equipment are for exclusive use with such equipment. 

• The following products are recommended for use with the BMS-125E: 

Cannulas for Bramsys stereotactic apparatus 

Bramsys adapters 

Bramsys screws 

Bramsys electrodes for functional surgery  

 

ATTENTION: the use of any part, accessory, or material not specified herein is the user’s sole 

responsibility. 

3.3 Warnings and cautions 

• Avoid dropping, twisting, crushing, impacting, or submitting the equipment to any actions that may deform 

it. 

• Deformations in the structure of the equipment will compromise its accuracy and may cause damage to 

the patient. 

• Properly secure the equipment’s moving parts. 
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• Movements of the stereotaxic coordinates, resulting from the accidental displacement of these parts, will 

change the position of the predetermined target, which may be harmful to the patient. 

• The equipment must be properly cleaned and sterilized according to the instructions contained in the user 

manual. Failure to do so may result in bacterial and/or viral contamination, which may cause infectious 

complications for the patient. 

• Excessive force when fixing the stereotactic frame to the skull beyond that supported by the bone 

structure may cause injuries to the patient. 

• Improper reading of the equipment scales due to user misinterpretation or wear of the paint on the scales 

can cause bad execution of the procedure, which may be harmful to the patient. 

 

 

4. STORAGE, CLEANING, CONSERVATION, AND TRANSPORT 

 

4.1 Storage 

• Keep the equipment in its original packaging, in a place protected from excessive humidity, rain, and 

direct sunlight. 

4.2 Cleaning and disinfection 

• Use a neutral soap and warm water only to clean the equipment externally after each procedure. Use 

compressed air or a clean, dry cloth to dry it. 

• Do not use organic solvents, such as thinners, or detergents containing solvents, such as ether, stain 

remover, gasoline, etc., to clean the equipment. Do not use aerosol or liquid spray applicators. 

• Do not use micro-abrasive material or steel wool for cleaning. 

• Wash the box using a soft sponge or wet cloth with water and neutral soap, and dry it after washing. 

 

4.3 Lubrication 

• Lubricate all parts that slide together, the ends of the locking screws of the millimeter side ruler holder 

and the vertical “Z” bar holder, the underside of the washers, and the contact surface of the arch on the 

millimeter tube using silicone or sterile Vaseline before starting the procedure. 

4.4 Conservation 

• Keep the equipment clean and dry for the next use. 

• Keep it in a clean and dust-free place. 

4.5 Transport 

• Avoid vibrations and impact, and do not drop the equipment. 

• Do not allow the equipment to be exposed to rain or excessive humidity. 

• All parts must be packed inside the shipping box. 

•   Check that all parts are correctly positioned and secured in place. 

 

 

5. DESCRIPTION OF PRODUCT EFFECTIVENESS AND SAFETY 

 

5.1 Undesirable side effects and contraindications 

 

• This equipment does not produce any undesirable side effects if all the recommendations described in 

this document are strictly complied with. The equipment has no contraindications. However, it can only 

be used or operated by a specialized medical professional or supervised by such professional. 
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5.2 Preventive maintenance 

 

• Return the equipment to Bramsys every 12 months for preventative maintenance to ensure its good 

working order and safety. 

5.3 Corrective maintenance 

 

• If there is a problem with the equipment or any of its parts, return it to Bramsys with a description of the 

problem. 

 

WARNING: request technical assistance through the Customer Service Center via +55 (11) 5013-0010 

or email at sac@bramsys.com.br. 

5.4 Description of safety and efficacy 

 

• Safety and efficacy in the use of the equipment can be ensured as long as the recommendations 

prescribed in the User’s Manual are strictly complied with. 

 

 

6. SYMBOLS 

 

 

Fragile, handle with care  
 

Careful! Consult accompanying 

documents  

 

This side up  

 

Maximum stacking limit  

 

Keep away from sunlight  

 

Keep dry  

 

Temperature limits  
 

Nonsterile  

 

 

7. WARRANTY TERMS 

 

Bramsys Indústria e Comércio Ltda. guarantees its original user customers that the equipment it manufactures 

is produced using state-of-the-art technology and strict quality control, thus ensuring its perfect functioning, 

provided that the conditions and terms below are complied with. 

 

WARRANTY  

The warranty, without any charge to the buyer, is limited to the replacement and/or repair of any defective parts 

or the correction of any production defect upon verification by our technical assistance. 

 

The replacement and/or repair referred to in the previous item does not apply to parts with natural wear and 

tear, as well as damage due to malpractice or negligence in the use of the equipment, or to parts that have been 

repaired or modified by people not accredited by Bramsys. 

 

Under no circumstances, should there be a need to replace any component covered by this term, the warranty 

period will be extended by adding any supplements to the replaced component. 

 

mailto:sac@bramsys.com.br
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EQUIPMENT 

This warranty is valid for all Bramsys equipment produced by Bramsys Indústria e Comércio Ltda. 

 

INSTALLATION AND USE 

The installation and/or operation of the equipment, as well as its working conditions, must comply with the 

Bramsys standards contained in this Instruction manual. The warranty clauses will be void if the conditions are 

different from those indicated. 

 

WARRANTY LOCATION 

Equipment repair will be carried out at our facilities. The transport freight (round trip) will be paid by the buyer. 

 

WARRANTY PERIOD 

Starting from the date of issue of the sales invoice by Bramsys or its resellers, being valid for a period of 12 

months. The warranty period for accessories is determined by their useful life or ninety (90) days, whatever 

comes first. 

 

RESPONSIBILITY 

This warranty is only valid for equipment in use and in the possession of the original buyer. Bramsys’ liability is 

limited to the replacement and/or repair of components, with the exception of any damages for lost profits or 

compensation for any other indirect or immediate damages. 

 

 

Request technical Assistance through the Consumer Assistance Service via +55 (11) 5013-0010, or email 

sac@bramsys.com.br. 
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